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Applicability 
 
This procedure is applicable to the entire NCSX Project.  
 
Introduction 
 
With few exceptions, all NCSX Project documents will be stored electronically.  Drawings and models 
will be stored on the Pro/INTRALINK database and other documentation (e.g., project Plans and 
procedures, specifications, analyses, memorandum, etc.) will be stored on the NCSX Engineering Web 
Page http://www.pppl.gov/me/NCSX_Engineering/ .  These documents will be posted in pdf format to 
facilitate easy access.  Since NCSX Project files will be electronic in nature, it is appropriate to utilize an 
electronic review and signature process.  In order to access pdf documents, a user need not have an 
established electronic signature profile.  However, with the exception of DOE-level project plans, all 
documents will be signed electronically. 
 
The NCSX Project has adopted the Digital Signature Process and Security embodied in Adobe 
Acrobat.  In order to ensure consistency across the NCSX Project, Adobe Acrobat 5.0 (or 
later) version is required.  In Adobe Acrobat, this is called the “Acrobat Self-Sign Security.’  The 
Adobe Acrobat system permits personnel required to sign documents to create their own secure 
electronic signature (via password protection), permit authentication of the electronic signatures, and 
permit casual users to also view completed documents with the full signatures visible.  Inherent in all 
these tasks is the requirement that all users (whether personnel signing documents or casual 
viewers) establish their own User Attribute profile.  This profile will permit personnel to set up their 
own protected electronic signature or permit the casual user to verify all the signatures.  Without the 
unique User Attribute, the electronic signature process will not work correctly.  
 
Once electronically signed, the document (be it drawing or other project document) is frozen and 
additional changes precluded without changing the file name.  The signed document will then be posted 
in the appropriate electronic project files. Changes to approved documents are then processed in 
accordance with the NCSX Configuration Management Plan. 
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Referenced Documents 
 
NCSX-PLAN-PEP NCSX Project Execution Plan 
NCSX-PLAN-SEMP NCSX Systems Engineering Plan 
NCTX-PLAN-CMP NCSX Configuration Management Plan 
PPPL ES-DRFT-002 PPPL Pro/INTRALINK Users Guide 
 
Procedure 
There are two distinct, albeit similar, tracks for signing drawings and models and for signing other 
project documents.  This procedure consists of five sections: 
 

A. Establishing a User Attribute and Electronic User Signature Profile 
B. Verifying Signatures 
C. Setting up the signature blocks for a document and/or drawing 
D. Signing drawings and models 
E. Signing other project documents 
F. Obtaining copies of approved documents 

 
It should be noted that these directions were generated assuming a PC.  It is recognized that 
the interfaces may appear slightly different on a MAC, however, the processes are the same. 
 
A. Establishing a User Attribute and Electronic User Signature Profile 
The key element for electronic signature is for each user/person signing documents establish his or her 
own unique password-protected User Attribute and signature file (if the person is required to sign 
documents) or certificate that can only be accessed by the user.  This need only be accomplished once.  
Once the User Attribute (and electronic signature if needed) is accomplished, the processes of signing a 
document or verifying other signatures are reasonably straightforward.   
 
It may be desirable to create at least two electronic “signatures”.  The first electronic “signature” should 
be a full name (full name “signature” for signing most documents or drawings) and an initials “signature” 
(for signing documents with only limited space availability).  Note:  Due to Identity Theft concerns, 
only electronic “text” signatures will be established => NO script signatures. 
 
Attachment 1 to this procedure provides a visual step-by-step representation of this process.  
 
Responsibility Action 

 
User  1. Open Adobe Acrobat 5.0 (or later version) and select Tool Menu => Self-Sign 

Security => Log In 

 2. When Self-Sign Security – Log In dialogue box opens, select New User Profile 
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 3. When Create New User Profile dialogue box opens, fill in the User Attributes: 

• Name (Required) 
• Organization Name (Optional) 
• Organization Unit (Optional) 
• Profile File => select unique password and confirm that password) 

 4. Close Create New User dialogue box by clicking “OK”.  If only created to 
view and verify electronically signed documents/drawings, this completes the 
necessary steps.  If need to also create an electronic signature, continue to Step 
A5 below. 

 5. After User Attribute file established, select Tool Menu again => Self-Sign 
Security => User Settings 

 6. When Self-Sign Security – User Settings for XXXX (name of user) appears, 
select “Signature Appearance” and “New” button.  

 7. When “Configure Signature Appearance” dialogue box appears, name the title 
of the signature (e.g., Full Name Text Signature, Initials Text Signature, etc.) in 
the Title section and then in the “Configure Graphic” section, select “NAME”.  
DO NOT SELECT IMPORT “IMPORTED GRAPHIC.”  

 8. In the “Configure Text” section, select the appropriate “show” options.  It is 
recommended that only the “Date” block be selected to preclude too much 
detail on the electronic signature. 

 9. Select “OK” to close the “Configure Signature Appearance” dialogue box.  
Your electronic signature is now established.  

 10. If other specific signature appearances are required (e.g., initials), repeat steps 
A3 through A10 until all desired electronic signature options are determined. 

 11. When completed setting up your signature profiles, the final process is to e-mail 
your certificates to a central repository so that any other users may download 
validated certificates when verifying signatures. There are slightly different 
processes depending on the E-mail program in use.   

 12. Under the Tool Menu, select “Self-Sign Security” and then “User Settings”. 
 13. When the “Self-Sign Security - User Settings for XXXX”, select “User 

Information”. Outlook users should then proceed to step A14 and Eudora and 
Entourage users should proceed to step A18. 

 14. Outlook users should select “E-Mail”. 
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 15. When the “E-Mail Certificate” dialogue box appears, complete the information 

as follows” 
• In “Message to” section, fill-in the e-mail address of the Systems Engineering 

Support Manager ( bsimmons@pppl.gov ).  The Systems Engineering 
Support Manager will maintain the complete folder of validated certificates 
on the Systems Engineering Web Page <  > 

• Fill-in your contact information (usually a phone number) 
• Select “E-Mail” option 

 16. When the “Acrobat Certificate Exchange File from XXXX” dialogue box 
appears, select “Send” option to send e-mail.  Note: You may also e-mail your 
certificate directly to other users if so desired.  However, ensure that a 
certificate is e-mailed to the Systems Engineering Support Manager. 

Systems 
Engineering 
Support 
Manager 

17. Receives e-mailed certificate and posts in “Validated Certificates” folder 
accessible via links from the NCSX Engineering Web page 
http://www.pppl.gov/me/NCSX_Engineering/ . 

User 18. Eudora and Entourage users should select “Export to File…” 
 19. Place the Certificate File (.fdf) on your desktop or in a folder.  DO NOT 

change the Object name. 
 20. Using Eudora or Entourage, send the an e-mail with the Certificate File (.fdf) to 

the Systems Engineering Support Manager ( bsimmons@pppl.gov ).  The 
Systems Engineering Support Manager will maintain the complete folder of 
validated certificates on the Systems Engineering Web Page <  >.  Note: You 
may also e-mail your certificate directly to other users if so desired.  However, 
ensure that a certificate is e-mailed to the Systems Engineering Support 
Manager. 

Systems 
Engineering 
Support 
Manager 

21. Receives e-mailed certificate and posts in “Validated Certificates” folder 
accessible via links from the NCSX Engineering Web page 
http://www.pppl.gov/me/NCSX_Engineering/ 

 
B. Verifying Signatures 
When a document is forwarded for signature and that person wants to verify the signatures before 
signing, or a casual user desires to verify signatures in order to remove the electronic question mark (?), 
the person must first ensure that they have an electronic User Attribute established in accordance with 
the procedure outlined in Section A previously.  It should be noted here that the “verification” 
process is linked to the Adobe Acrobat Digital Signature Verification process and is not 
necessarily a physical verification process.  However, as indicated in this procedure, the user 
may call the previous signatures to confirm that they did indeed electronically sign the 
document and to match the number of their certificate. 
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The Systems Engineering Support Manager is responsible for maintaining an up-to-date list of validated 
signatures.  This list can be found in tabular format in via links from the NCSX Engineering Web page 
http://www.pppl.gov/me/NCSX_Engineering/ . 
 
The person approving the document is required to verify all the previous signatures before 
signing.  Other users have the option to either accept that this verification occurred before the 
document was approved or, at their option, may also verify the signatures. 
 
Each time the document is opened once posted, all the electronic signatures will appear, albeit with a 
question mark (?) that indicates that the signatures on the opened document have not been re-verified.  
Since the person approving the document is required to verify all the previous signatures 
before signing, anyone opening the document can assume that the approving official has verified the 
signatures before approving the document.  Nonetheless, at their option, users may also verify the 
signatures, although it is not required.  This section outlines the process for verifying signatures.  
 
Attachment 2 to this procedure provides a visual step-by-step representation of this process.  
 
Responsibility Action 

 
Approving 
Official or User  

1. Open the document using Adobe Acrobat 5.0 (or later version) and Log In 
using the procedures in Section A.  When document is open, all signatures will 
have a question mark (?) appearing.  The Approving Official must first 
verify all signatures before signing.  Other users have the option to verify 
signatures or to accept that all signatures were verified before the document 
was approved. 

 2. Open the NCSX Engineering Web page 
http://www.pppl.gov/me/NCSX_Engineering/ and select the link to the 
Validated Signatures web page.  Once at the Validated Signatures Web page, 
select the link to the table of validated signatures.  This table provides the 
validated certificate numbers for each user with an electronic signature.   

 3. To verify a signature for the first time, right click the signature field that is to be 
verified.  Right-clicking signature field will automatically open another dialogue 
box.  Select “Verify Signature”.  If the all the signatures had been previously 
verified and added to “Your Trusted Certificates” section in the Users Profile, 
proceed to step B8.  

 4. Selecting the “Verify Signature” will result in the “Self Sign Security – Validation 
Status” dialogue box appearing with the message, “Signature validity is 
UNKNOWN”.  Select “Verify Identity.” option. 

 5. When the “Verify Identity” dialogue box appears, confirm the MD5 and SHA1 
Fingerprint numbers with those on the Validated Signature Web list.   
• If they are the same, select “Add to List”.   
• If they are not the same, call the contact information for the certificate owner 

and notify the Systems Engineering Support Manager of the discrepancy. 
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 6. When convinced of the certificate validity, check the “Add to List” box to add 
the list to your “Trusted Certificate” list.  The “Self-Sign Security – Alert” 
dialogue box will appear indicating that this signature has been added to your 
“Trusted Certificate” list and the question mark (?) will change to a check (v) 
indicating that the signature has been verified.   

 7. Repeat steps B2 through B6 until all the desired validated certificates are 
transferred to the user’s “Trusted Certificate” folder, all signatures are verified, 
and all question marks (?) are changed to a checks (v) indicating that the 
signatures have been verified.  

 8. If the signatures have all been previously verified and are in your “Trusted 
Certificates” list, you need only select Tool Menu => “Digital Signatures”.  
When the adjacent dialogue box opens, select “Verify All Signatures”. 

 9. When the “Digital Signature – Alert” dialogue box appears, select ”OK”. This 
will change the question marks (?) to checks (v) once the signatures are 
verified.   

 10. The ”Digital Signature –Alert” dialogue box will then change to show 
“Verification Complete” – check “OK” to complete the verification process. 

 
C. Setting Up and Modifying The Signature Blocks For Documents And/Or Drawings 
The person that who originates the document (either drawing or other document) is responsible for 
providing the source document to the responsible official (either the NCSX Systems Engineering 
Support Manager or NCSX Engineering Manager for controlled documents other than drawings and to 
the Design Integration Manager for drawings).  The responsible official will then convert the source 
document to pdf format, establish the initial document security for that document,  and establish the 
signature field for each required signature.  The responsible official will then distribute the pdf document 
for signature. 
 
Attachment 3 to this procedure provides a visual step-by-step representation of this process. 
 
Responsibility Action 

 
Originator of the 
Document  

1. Saves the source document in the original format and forwards the document 
electronically to the responsible official (either the Systems Engineering Support 
Manager or Engineering Manager for controlled documents other than drawings 
and to the Design Integration Manager for drawings). 

Responsible 
Official 

2. Converts the source document to a pdf format. 

 3. Under the File Menu, select “Document Security.”  
 4. When the “Document Security” dialogue box appears, select ”Acrobat 

Standard Security”.  
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 5. When the “Standard Security” dialogue box appears: 

• Check the “Password Required to Change Permissions and Passwords” in 
the “Specify Password” section and enter whatever password desired as 
the password.  Ensure that the password is remembered, as it will be 
needed to modify the signature fields. 

• In the “Permissions” section, select 128-bit RC4 (Acrobat 5.0) Encryption 
Level and check both blocks: 
o “Enable content Access for the visually Impaired” 
o “Allow Content Copying and Extraction” 

• In the “Changes Allowed” section, select: 
o For a drawing, “Comment Authoring, Form Field Fill-In or Signing 
o For all other documents, “Only Form Field Fill-In or Signing” 

• In the “Printing” section, ensure that “Fully Allowed” appears  
• Check “OK” when completed with the above 

 6. When “Password dialogue box appears, retype in the password selected in C4 
above. 

 7. Click the Form Tool icon to activate it 
 8. Drag the cross hair over the area where the signature will be placed 
 9. When the “Field Properties” dialogue box appears: 

• Type in the Name of the person to sign the document 
• In the “Type” block, ensure that “Signature” is selected (vs. the “Text” 

default) 
• In the “Short Description” section, enter “Prepared by, Reviewed by, or 

Approved by” or other appropriate descriptor of the action indicated by the 
signature 

• Unless otherwise desired, leave “Border” section at the default settings 
• In the “Text” section, select the desired font color and type  
• Unless otherwise desired, leave “Common Properties” section at the default 

setting 
• Select “OK” when the above settings are selected. 

 10. Repeat step C8 as many times as necessary for the number of signatures 
desired. 

 11. Save the document and distribute to the personnel required to sign the 
document in accordance with the procedures in Section D. 

 12. Should a signature field need to be modified or corrected, follow steps C12 
through C20 below.  

 13. Under File Menu, select “Document Security’. 
 11. When the “Document Security” dialogue box appears, select “Change 

Settings”. 
 12. When the “Password: dialogue box replaces the “Document Security” dialogue 

box, type in the password previously selected by the originator in step C4 
above. 
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 14. When the “Standard Security” dialogue box appears, select “Cancel”.  

Selecting “OK” will preclude changing the signature field blocks. 
 15. When the “Document Security” reappears, select “Close”. 
 16. Right click the signature field block to be changed and a dialogue box will 

appear with several options. 
 17. Select “Delete Signature Field”. 
 18. When the “Digital Signature –Alert” dialogue box appears asking if you want to 

delete the selected field, select “OK” to delete the signature field. 
 19. Reapply the corrected/modified signature field block in accordance with steps 

C2 through C10. 
 20. When all fields have been corrected as necessary, save the document and 

distribute to the personnel required to sign the document in accordance with the 
procedures in Section D. 

 
D. Signing Drawings And Models 
Drawings and models prepared electronically have a slightly more different sign-off process than other 
NCSX documents in that the final signature will be by the PPPL Drafting Supervisor who then signs and 
places a “Released for Fabrication”, “Pending ECN XXXX”, or “NCR-XXX” stamp on the drawing. 
The originator of the document will be the first person to sign the document. 
 
Attachment 4 to this procedure provides a visual step-by-step representation of this process. 
 
Responsibility Action 

 
Originator of the 
Document  

1. Log-In in accordance with the procedures of Section A of this procedure. 

 2. Opens document in PDF format. 
 3. If not already done, establishes the document security and signature blocks in 

accordance with the procedures of Section C of this procedure.  
 4. To sign the document, activate the “Hand” icon by clicking it and then right click 

on his signature area field. 
 5. When the “Self-Sign Security – Sign Document” dialogue box appears: 

• Type in the user’s password in the “Confirm Password” section 
• Select or edit reason for signing in the “Reason for Signing Document” 

section 
• At the option of the user, fill in the “Location” and “Contact Information” 
• Select the name of the signature determined in procedure step A7 in the 

“Signature Appearance” section or edit the signature appearance per 
procedure step A7 

• Check “Save” when completed with the above and the signature will appear 
with a check mark (v). 

 6. The “Self-Sign Security – Validation Status” will appear indicating that the 
“Signature is Valid” 
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 7. Save document and forwards document electronically in PDF format 
Subsequent 
Signers 

8. Open document and verify previous signatures (if desired) in accordance with 
Section B of this procedure.  

 9. Repeat steps D1 though D6  
 10. Repeat step D7 until the PPPL Drafting Supervisor is next signer.  When the 

PPPL Drafting Supervisor is the next signer, proceed to step D11. 
PPPL Drafting 
Supervisor 

11. Open document and verify previous signatures (REQUIRED) in accordance 
with Section B of this procedure. 

 12. If document is satisfactory, sign document in accordance with steps D1 through 
D6. 

 13. Activate the “Stamp” icon and move icon of stamp to the desired location.  Left 
click mouse (three button mouse) to set the stamp location. 

 14. Size the stamp top the proper size by dragging the stamp corners. 
 15. Move the stamp icon over the stamp and right click the mouse button. 
 16. When the “Stamp Properties” dialogue box appears, select the proper stamp 

message.  Note: After the stamp is placed a “Document was Modified” 
warning is set in the Signature Area.” warning is set in the Signature 
Area. 

 17. Save fully signed drawing and place in the appropriate NCSX 
Pro/INTRALINK database “001_Released_Drawing_PDF_Format” folder in 
accordance with PPPL ES-DRFT-002. 

 
E. Signing Other Project Documents 
Signing other project documents (e.g., Plans, Procedures, etc.) is very similar to the steps outlined in 
Section D above.  
 
Attachment 5 to this procedure provides a visual step-by-step representation of this process. 
 
Responsibility Action 

 
Originator of the 
Document  

1. Log-In in accordance with the procedures of Section A of this procedure. 

 2. Opens document in PDF format. 
 3. If not already done, establishes the document security and signature blocks in 

accordance with the procedures of Section C of this procedure.  
 4. To sign the document, activate the “Hand” icon by clicking it and then right click 

on his signature area field. 
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 5. When the “Self-Sign Security – Sign Document” dialogue box appears: 

• Type in the user’s password in the “Confirm Password” section 
• Select or edit reason for signing in the “Reason for Signing Document” 

section 
• At the option of the user, fill in the “Location” and “Contact Information” 
• Select the name of the signature determined in procedure step A7 in the 

“Signature Appearance” section or edit the signature appearance per 
procedure step A7 

• Check “Save” when completed with the above and the signature will appear 
with a check mark (v). 

 6. The “Self-Sign Security – Validation Status” will appear indicating that the 
“Signature is Valid”   

 7. Save document and forwards document electronically in PDF format 
Subsequent 
Signers 

8. Open document and verify previous signatures (if desired) in accordance with 
Section B of this procedure.  

 9. Repeat steps E1 though E6  
 10. Repeat step E7 until the Approving Official is next signer.  When the Approving 

Official is the next signer, proceed to step E11. 
Approving 
Official 

11. Open document and verify previous signatures (REQUIRED) in accordance 
with Section B of this procedure. 

 12. If document is satisfactory, sign document in accordance with steps E1 through 
E6. 

 13. Forward approved document to the NCSX Engineering Project Web custodian 
for filing. 

NCSX Project 
Engineering Web 
Custodian 

14. File the Approved document in PDF format on the NCSX Engineering Web 
page http://www.pppl.gov/me/NCSX_Engineering/ in the format indicated in 
the NCSX Data Management Plan (NCSX-PLAN-DMP). 

  15. Obtain original media version (Word, etc.) from the originator and files this 
copy in the NCSX Engineering Web page folder in this format as indicated in 
the NCSX Data Management Plan (NCSX-PLAN-DMP). 

 
F. Obtaining Copies Of Approved Documents 
Approved documents will be posted on either the Pro/INTRALINK database for electronic drawings 
and models or on the NCSX Engineering Web Page http://www.pppl.gov/me/NCSX_Engineering/ for 
all other project documents.  Accessing these project files is relatively straightforward and will not be 
covered here.  However, it is an anomaly of the Adobe Acrobat Digital Signature Process and Security 
System that the signatures of all approved documents will contain a question mark (?).  Section B of this 
procedure outlines the steps to validate the signatures if so desired.  However, it the responsibility of the 
approving official to verify the signatures before signing the document. 
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Attachments 
Attachment 1: Establishing A User Attribute And Electronic User Signature Profile 

Attachment 2: Verifying Signatures 

Attachment 3: Setting Up and Modifying The Signature Blocks For Documents And/Or Drawings 

Attachment 4: Signing Drawings And Models 

Attachment 5: Signing Other Project Documents 
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1. Choose Tools => Self-Sign 
Security => Login 

2. New User Profile => Then fill 
in the User Attributes. 

1 

2 
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1. Choose Tools => “Self-Sign 
Security” => “User Settings” 

2. Then => “Edit” to modify 
appearance.   

3. Select “Name” 
 

1 

2 

3 
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Drawing Title Block Details 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Signature can be 
expanded to show 
details. 

The signature area shows date and time signed, the 
person’s signature and a check indicating it is a valid 
signature. 
 

When the key symbol is activated you can select “show 
Signatures” which provides signing details. 
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Other Documents  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Signature can be expanded to 
show details. 

The signature area shows date and time signed, the person’s signature and a 
check indicating it is a valid signature. 
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E-mailing Certificates 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Under Tool Menu, select “Self-Sign 
Security” 

2. Select “User Settings…” 

1 

2 
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E-mailing Certificates  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. When dialogue 
box appears, 
select “User 
Information” 
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E-mailing Certificates Using Outlook  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Select “E-Mail” 
2. When the “E-Mail Certificate” dialogue box appears: 

• Fill-in e-mail address of the Systems Engineering Support 
Manager  ( bsimmons@pppl.gov ) 

• Fill-in your contact information 
• Select “E-Mail” option 

1 
2 
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E-mailing Certificates Using Outlook 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. When the “Acrobat Certificate Exchange File for 
XXXX” appears, select “Send”.  NOTE:   You 
may also directly e-mail certificate to another user if 
desired. 

2. Upon receipt of e-mail, Systems Engineering 
Support Manager will post on the “Validated 
Signatures” folder which is accessible via the NCSX 
Engineering Web page 
http://www.pppl.gov/me/NCSX_Engineering/  



NCSX PROCEDURE:  NCSX–PROC–005-01 

Attachment 1 

Establishing A User Attribute And Electronic User Signature Profile 

Page: 9 of 10 

Controlled Document 
THIS IS AN UNCONTROLLED DOCUMENT ONCE PRINTED.  Check the NCSX 

Engineering Web prior to use to assure that this document is current. 

 

 

E-mailing Certificates Using Eudora or Entourage 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Select “Export to File” 
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E-mailing Certificates Using Eudora or Entourage 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Place the Certificate File (.fdf) on desktop or in a 
folder.   

2. Using Eudora, e-mail the Certificate file to the 
Systems Engineering Support Manager 
<bsimmons@pppl.gov> .  NOTE:   You may also 
directly e-mail certificate to another user if desired. 

3. Upon receipt of e-mail, Systems Engineering Support 
Manager will post in the “Validated Signatures” folder 
which is accessible via the NCSX Engineering Web 
page http://www.pppl.gov/me/NCSX_Engineering/. 
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DO NOT CHANGE THE 
OBJECT NAME. 
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First Time Verification 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Right click signature block 
2. Select “Verify Signature” 
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First Time Verification 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Select “Verify Identity” 
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First Time Verification 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. To verify the identity of the owner of the certificate, check the Validated 
Signature list that can be accessed via a link on the NCSX Engineering 
Web page http://www.pppl.gov/me/NCSX_Engineering/ to confirm that 
the fingerprint numbers matches that on the users computer screen.  

2. Select “Add to List” once the user is satisfied that the certificate is valid 
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First Time Verification 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Check “OK” 
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First Time Verification 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Once the signature is added to the ‘Trusted Certificate’ list, the 
question mark (?) will change to a check mark (v) in both the 
“Self-Sign Security – Validation Status” and in the signature block 
field.  Once on the ‘Trusted Certificate’ list, it need not be added 
again (unless deleted on purpose.   

Note:  Approving Official must verify all previous signatures 
prior to signing. 
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Subsequent Verification when all Signatures in ‘Trusted Certificate’ File 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. When a document is selected, Signature 
Blocks will Contain Question Marks (“?”)  

2. Under Tools Menu, select “Digit 
Signatures” 

3. When another dialogue box appears, select 
“Verify All Signatures” 
4.  
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Subsequent Verification when all Signatures in ‘Trusted Certificate’ File 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Each time the document is 
subsequently opened, question 
marks (?) will appear 

2. When Digital Signature – Alert 
dialogue box appears, select OK 
to start verification process  
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Subsequent Verification when all Signatures in ‘Trusted Certificate’ File 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1. When all signatures verified, question 
marks (?) will change to check marks (v) 
and the “Verification Complete” notice will 
appear 

2. Check “OK” to complete verification 
process. 
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To View “Trusted Certificates’ Folder 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Under Tools Menu, 
select “Self-Sign 
Security” and then 
select “Users Settings” 

2. Then select “Trusted 
Certificates” to view 
whose signatures have 
been previously 
verified. 

2 



 

NCSX PROCEDURE:  NCSX–PROC–005-01 

Attachment 3 

Setting Up and Modifying the Signature Blocks on a Document or Drawing 

Page: 1 of 11 

 

Controlled Document 
THIS IS AN UNCONTROLLED DOCUMENT ONCE PRINTED.  Check the NCSX 

Engineering Web prior to use to assure that this document is current. 
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The creator of the document or drawing saves the document in the 
original format and then sends to the responsible official 

 
1. Creator saves source document and sends to the responsible official (Design Integration 

Manager for drawings and Systems Engineering Support Manager/Engineering Manager for 
all other documents) 

2. Responsible Official saves document in pdf format. 
3. Under the File Menu, select “Document Security”  
4. When the “Document Security” dialogue box appears, select “Acrobat Standard Security”  
5. When the “Standard Security” dialogue box appears, select  

• Check “Password Required…” and enter password selected by the originator 
• Select “128-bit RC4 (Acrobat 5.0)” encryption 
• Select both “Enable Content Access…” and “Allow Content Copying…” 

6. In Changes section, select “Only Form Field Fill-In or Signing” for documents or 
“Comment Authoring, Form Field Fill-In or Signing” for drawings 

4 

5 
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Establishing Signature Blocks for a Document 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Under “Tools Menu” 
select “Acrobat 
Standard Security” and 
then  “Standard 
Security” and Master 
Password selected by 
the originator. 

2. When “Password” 
dialogue box appears, 
type in password 
selected by the 
originator to confirm 
the password 
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Establishing Signature Blocks for a Document 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Click the Form Tool to activate it => a cross 
hair will appear 

2. Drag the cross hair over the area where the 
signature will be placed  

3. In the field properties box that appears inter 
the Name (e.g. Sig 1in this example).  Make 
sure that the “Type” is set to 
“Signature” (default is Text).  Borders, etc 
can be added if desired. 
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Establishing Signature Blocks for a Document 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. After all signature blocks 
or fields are established, 
the creator should save 
the document 

Note:  The creator could 
sign the document before 
the document is saved. 
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Establishing Signature Blocks for a Drawing 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. From the “Tools” Menu, select 
“Self-Sign Security” and “Log In” 

2. When “Self-Sign Security – Log In” 
dialogue box appears, input your 
User password and select “Log In”. 

3. Repeat steps to set drawing 
password as outlined earlier. 
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Establishing Signature Blocks for a Drawing 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Cog Engineer 

1. Click the form tool icon to activate it 
=> a cross hair will appear 

2. Drag the cross hair over the area 
where the signature will be placed 

3. In the Field Properties box that 
appears inter the Name (e.g. Sig 2).  
Make sure that there is no check on 
Border or Background (when used 
in a drawing title block).  Also make 
sure that the Type A Short 
Description such as Cog Engineer, 
Designer, etc., can also be added.  
Make sure that the “Type” is 
set to “Signature” (default is 
Text).   

4. Repeat this process for every 
signature area.  For drawings there 
will be several signatures (Sig 1, Sig 
2, Sig 3, Sig 4)   

5. Save the drawing once the signature 
field blocks are established. 
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Modifying Signature Block Fields 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Under File Menu select “Document Security”.  When “Document Security” 
dialogue box appears, select “Change Settings”. 

2. When “Password” dialogue box appears, retype in password selected by the 
originator and then select “OK”.  
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Modifying Signature Block Fields 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. When “Standard 
Security” dialogue 
box appears, select 
“Cancel” (selecting 
“OK” will preclude 
any modifications). 
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Modifying Signature Block Fields 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. The “Document Security” dialogue box will 
then reappear.  Check “Close”. 
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Modifying Signature Block Fields 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Right click on the signature block to be modified 
2. When the dialogue box appears, select “Delete Signature 

Field” 
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Modifying Signature Block Fields 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. When “Digital Signatures – Alert” dialogue box appears, 
select “OK” to delete the signature field. 

2. Reapply corrected signature field block in accordance with 
the procedures described earlier in this Attachment  
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The originator will be the first to sign a 
drawing  

 
1. Activate the “Hand” icon to activate it. 
2. Right click on the signature area.  A Sign 

Signature Field will appear.  Select Sign 
Signature Field and the Self-Sign Security 
dialog will come up. 

3. Fill in your password and the reason for 
signing the document (use pull down 
window). 

1 
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\ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. After the first signature, the Title Block will appear 
2. Activate the document key and “show signature” to 

view signatures 
3. Repeat process until Drafting Supervisor’ signature is 

the next signature 
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Drafting Supervisor Must First Validate all Previous Signatures 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. After Logging In, from Tools Menu, the Drafting 
Supervisor selects “Digital Signatures” and then 
“Verify Signatures” 

2. Drafting supervisor should validate signatures in 
accordance with procedures outlined in Section 
B (Attachment 2).  Once validated the question 
marks (?) changes to a check mark (v) 
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1. To sign the document, the Drafting Supervisor activates the 
“Hand” icon 

2. Right click on the signature area.  A Sign Signature Field will 
appear.  Select Sign Signature Field and the Self-Sign Security 
dialog will come up. 

3. Fill in your password and the reason for signing the document 
(use pull down window) 

4. Click “Save” 
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Drafting Supervisor Places Stamp 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: After the stamp is 
placed a “Document was 
modified” warning is set 
in the Signature area. 

1. Activates the “Stamp” 
icon. 

2. An icon of a stamp will 
appear.  Move the stamp 
to the desired location and 
left click mouse (three 
button mouse) to set 
stamp.  Drag stamp 
corners to set it to the 
desired size. 

3. Move the icon over the 
stamp and right click 
mouse button and open 
Properties to change stamp 
message. 
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1. Drafting 
Supervisor 
saves 
drawing 1 
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The drawing is complete and now ready 
to be placed in the released area of the 

Pro/INTRALINK database 
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To Compare Signed Version to Earlier Unsigned Version 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Right click on signatures 
and activate Compare 
Signed Version to 
Current Version. 

Changes Made 

Current Version Version Signed by 
Engineer 
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When a drawing is reopened, question marks (?) will appear until the signatures are re-verified.  A user can only 
verify signatures => the signatures cannot be deleted by anyone  
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1. User Logs In and confirms 
password 

The originator of the document must first set up the signature 
block fields in accordance with Section C (Attachment 3) 
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1. After setting up the 
signature block fields, 
the originator saves the 
document. 
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1. User Logs In and activates the “Hand” 
Icon 

2. Right click on the signature area.  A 
Sign Signature Field will appear.  Select 
Sign Signature Field and the Self-Sign 
Security dialog will come up. 

3. User fills in their password and the 
reason for signing the document (use 
pull down window). 

4. Each User repeats process until all 
Approving Official signature  

5. Approving Official must first verify 
all previous  signatures prior to 
signing in accordance with Section B 
(Attachment 2) 

6. Approving Official then sends 
approved document to the NCSX 
Engineering Web page for posting. 
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